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WMS 11.4 Tutorial 

SWMM Modeling 
Learn how to link a hydrologic model to the SWMM storm drain model 

Objectives  

Build a rational method hydrologic model and compute sub-basin flows. Import storm drain network 
information and link the storm drains to the hydrologic model. Run the flows from the hydrologic model 
through the storm drain model using either EPA SWMM or XPSWMM. 

Prerequisite Tutorials 

• Rational Method Interface 

• Using TINs 

Required Components 

• WMS Core 

• EPA SWMM Model 

• XPSWMM Support 

Time 

• 30–60 minutes 

 

WMS 11.4 
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1 Introduction 

The Storm Water Management Model (SWMM) is a hydrologic and hydraulic analysis 
tool used primarily for designing and analyzing storm drain systems. Hydrologic 
parameters are defined to obtain hydrographs and peak flows which can then be fed into 
the hydraulic component of the model. The hydraulic component lets engineers analyze 
the capacity of a current storm drain system or design a system to meet certain inflow 
conditions.  

WMS supports exporting data file formats for both EPA SWMM, developed by the Water 
Supply and Water Resources Division of the US Environmental Protection Agency’s 
National Risk Management Research Laboratory, and XPSWMM, developed by XP 
Software. 

In this tutorial, a drainage simulation will be set up based on the rational method for a 
proposed subdivision. The basic steps for defining a SWMM input file, running the 
numeric model, and viewing the results will be shown. These steps include defining runoff 
coefficients, computing flows using the rational method, importing a pipe network, running 
SWMM and viewing the results, and routing hydrographs using SWMM and viewing the 
results. 

2 Getting Started 

Starting WMS new at the beginning of each tutorial is recommended. This resets the 
data, display options, and other WMS settings to their defaults. To do this: 

1. If necessary, launch WMS. 

2. If WMS is already running, press Ctrl-N or select File | New… to ensure that the 
program settings are restored to their default state. 

3. A dialog may appear asking to save changes. Click Don’t save to clear all data. 
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The Graphics Window of WMS should refresh to show an empty space. 

3 Defining Runoff Coefficients 

3.1 Importing the Subdivision Elevations 

A TIN may be used to help define elevations and slopes for the drainage area.  

1. Select File | Open… to bring up the Open dialog. 

2. Select “All Files (*.*)” from the Files of type drop-down. 

3. Browse to the stormrat\stormrat\ folder and select “cougarestates.tin”. 

4. Click Open to import the TIN and exit the Open dialog. 

5. Right-click on “  Coverages” in the Project Explorer and select New Coverage 
to bring up the Properties dialog. 

6. Select “Runoff Coefficient” as the Coverage type and click OK to close the 
Properties dialog. 

The project should appear similar to Figure 1. 

 

      Figure 1      The imported TIN 

3.2 Importing the Subdivision Layout 

The next step is to open a shapefile containing the geography of the proposed 
subdivision. 

1. Click Open  to bring up the Open dialog. 

2. Select “Shapefiles (*.shp)” from the Files of type drop-down. 

3. Select “cougarestates.shp” and click Open to import the shapefile and exit the 
Open dialog. 

4. Switch to the GIS Module  . 

5. Select Mapping | Shapes → Feature Objects to bring up the GIS to Feature 
Objects Wizard dialog (Step 1 of 3). 

6. Click Yes if asked to use all visible shapes. 
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7. Click Next to go to the Step 2 of 3 page of the GIS to Feature Objects Wizard. 

8. In the Mapping Preview section, select “runoff coefficient” from the Mapping 
drop-down in the RUNOFFC column. 

9. Click Next to go to the Step 3 of 3 page of the GIS to Feature Objects Wizard 
dialog. 

10. Click Finish to close the GIS to Feature Objects Wizard dialog. 

11. Turn off “  cougarestates.shp” and “  new” in the Project Explorer. 

This allows for better visibility of the subdivision polygons. 

3.3 Defining the Runoff Coefficients 

1. Switch to the Map Module . 

2. Using the Select Feature Polygon  tool, double-click on the upper polygon 
(labeled “1” in Figure 2) to bring up the Runoff Coefficient dialog. 

3. Enter “0.65” in the Enter the coefficient (0.0–1.0) for selected polygon field and 
click OK to close the Runoff Coefficient dialog. 

4. Repeat steps 2–3 for each of the other polygons in the subdivision, using the 
coefficients in the table below and referencing Figure 2: 

Polygon Coefficient 

lower left (2) 0.6 

lower center (3) 0.6 

lower right (4) 0.6 

streets (5) 0.98 

 

      Figure 2      Subdivision polygons 

4 Compute Flows from the Rational Method 

The next step is to set up the rational method analysis to compute peak flows for each 
sub-basin. The computed peak flows will then be used in the SWMM storm drain 
network. 
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4.1 Creating the Drainage Coverage 

1. Select “  Drainage” in the Project Explorer to make it active. 

2. Click Open  to bring up the Open dialog. 

3. Select “Shapefiles (*.shp)” from the Files of type drop-down. 

4. Holding down the Ctrl key, select both “runoff.shp” and “drainage.shp”. 

5. Click Open to import both shapefiles and exit the Open dialog. 

6. Switch to the GIS Module .  

7. Select Mapping | Shapes → Feature Objects to bring up the GIS to Feature 
Objects Wizard dialog (Step 1 of 4).  

8. Make sure only “runoff.shp” and “drainage.shp” are selected for mapping. If any 
other layers are selected, turn them off.  

9. Click Next to go to the Step 2 of 4 page of the GIS to Feature Objects Wizard 
dialog. 

10. Click Next to go to the Step 3 of 4 page of the GIS to Feature Objects Wizard 
dialog. 

11. Click Next to go to the Step 4 of 4 page of the GIS to Feature Objects Wizard 
dialog. 

12. Click Finish to close the GIS to Feature Objects Wizard dialog. 

13. Turn off “  runoff.shp”, “  drainage.shp”, and “  Runoff Coefficient” in the 
Project Explorer. 

This should simplify the display (Figure 3).  

 

      Figure 3      Drainage basins and streams for the subdivision 

14. Select “  Drainage” to make it active. 

15. Switch to the Map Module . 

16. Using the Select Feature Point/Node   tool, double-click on the node 
indicated by the arrow in Figure 3 to bring up the Drainage Feature Point Type 
dialog. 
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17. In the Type section, select Drainage Outlet and click OK to close the Drainage 
Feature Point Type dialog. 

18. Select Feature Objects | Compute Basin Data… to bring up the Units dialog. 

19. In the Model units section, click Current Projection… to bring up the Display 
Projection dialog. 

20. In the Horizontal section, select No projection and select “Feet (U.S. Survey)” 
from the Units drop-down. 

21. In the Vertical section, select “Feet (U.S. Survey)” from the Units drop-down. 

22. Click OK to close the Display Projection dialog. 

23. In the Parameter units section, select “Acres” from the Basin Areas drop-down 
and “Feet” from the Distances drop-down. 

24. Click OK to close the Units dialog. 

The area of each basin should now be displayed (Figure 4). 

 

      Figure 4      Drainage basins with areas displayed 

4.2 Computing Runoff Coefficients 

Composite runoff coefficients must be computed for each drainage area. A weighted 

average for each drainage area is calculated from data in the “  Runoff Coefficient” 
coverage. To compute the basin runoff coefficients: 

1. Switch to the Hydrologic Modeling Module . 

2. Select Calculators | Compute GIS Attributes… to bring up the Compute GIS 
Attributes dialog. 

3. In the Computation section, select “Runoff coefficients” from the drop-down. 

4. Click OK to close the Compute GIS Attributes dialog and compute the basin 
runoff coefficients. 
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Composite runoff coefficients for each drainage area are computed and displayed next to 
the area in each basin (Figure 5). 

 

      Figure 5      Areas and runoff coefficients 

4.3 Entering Times of Concentration 

The Time of Concentration (TC) for a basin can be calculated using a time computation 
coverage. In this tutorial, the TC values were pre-calculated and are provided below. 

1. Select “Rational” from the Model drop-down (Figure 6). 

 

      Figure 6      Rational model selected 

2. Using the Select basin  tool, double-click on basin 1B (see Figure 7) to open 
the Rational Method dialog.  

3. In the Parameters section, enter “5.0” as the Time of Concentration (Tc).  

4. Select “All” from the Show drop-down in the Display section. 

5. Enter the correct Time of Concentration (Tc) for each basin according to the table 
below.  

6. Click OK to close the Rational Method dialog. 

Basin ID TC 

2B 9.0 

3B 14.0 

4B 5.0 
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5B 8.0 

6B 6.0 

7B 11.0 

8B 7.0 

9B 8.0 

 

      Figure 7      Drainage basins 

A traditional rational simulation has now been set up for the Cougar Estates subdivision. 
The only remaining step is to define the IDF curves. 

4.4 Defining Rainfall Data 

1. Using the Select basin  tool, double-click on basin 3B to bring up the Rational 
Method dialog. 

2. In the Display section, select “Selected” from the Show drop-down. 

3. Click Compute… on the Compute I – IDF Curves to bring up the Rational 
Method —IDF Computation dialog.  

4. In the IDF curve computation section, select User Supplied Data and click  
Define Storm Data… to open the Input variables for IDF curves dialog.  

5. Select “25” from the Recurrence (yr) drop-down. 

6. Enter the precipitation values from the following table: 

5 min. (in/hr) 2.28 

10 min. (in/hr) 1.62 

15 min. (in/hr) 1.44 
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30 min. (in/hr) 1.06 

60 min. (in/hr) 0.69 

7. Click OK to close the Input variables for IDF curves dialog. 

8. In the upper right corner of the dialog, select “25-yr.” from the list. 

9. In the Intensity computation section, click Compute Intensity. 

10. Click Done to close the Rational Method — IDF Computation dialog. 

The rainfall intensity has now been computed for basin 3B. 

11. In the Display section, select “Outlets” from the Type drop-down and “All” from 
the Show drop-down. 

Notice that all of the outlets and basins are showing in the Parameters section. 

12. Click the Compute… button next to the Compute I – IDF Curves parameter for 
basin 1B to bring up the Rational Method — IDF Computation dialog. 

Notice that “25-yr.” is already selected in the text area at the upper right. 

13. In the Intensity computation section, click Compute Intensity and click Done to 
close the Rational Method — IDF Computation dialog. 

14. Repeat steps 12-13 for each remaining basin and outlet until all of them have a 
value in the Rainfall Intensity (I) row in the Rational Method dialog. 

Notice that the values in the Flowrate (Q) row for each basin and outlet have also been 
computed.  

15. Click OK to exit the Rational Method dialog. 

5 Importing the Pipe Network 

Now to import a pre-defined storm drain network, assign properties to the network, and 

link it to the “  Drainage” coverage. As mentioned above, a pipe network will be 
imported to use in the SWMM model. This network was defined as a shapefile and will be 
converted to feature objects in WMS. WMS can also open CAD files and convert them to 
feature objects. Alternatively, it is possible to manually create a pipe network using the 

Create Feature Arc  tool. 

1. Select then right-click “  Coverages” in the Project Explorer and select New 
Coverage to bring up the Properties dialog. 

2. Select “Storm Drain” from the Coverage type drop-down and click OK to close 
the Properties dialog. 

3. Click Open  to bring up the Open dialog.  

4. Select “Shapefiles (*.shp)” from the Files of type drop-down. 

5. Select “swmm_pipes.shp” and click Open to import the shapefile and exit the 
Open dialog. 

6. Switch to the GIS Module .  

7. Select Mapping | Shapes → Feature Objects to bring up the GIS to Feature 
Objects Wizard dialog (Step 1 of 3). 



WMS Tutorials  SWMM Modeling 

 

 Page 10 of 18 © Aquaveo 2026 

8. Make sure that “swmm_pipes.shp” is the only shapefile selected for mapping. If 
other shapefiles are displayed, turn them off.  

9. Click Next to go to the Step 2 of 3 page of the GIS to Feature Objects Wizard 
dialog. 

10. Click Next to go to the Step 3 of 3 page of the GIS to Feature Objects Wizard 
dialog. 

11. Click Finish to close the GIS to Feature Objects Wizard dialog. 

12. Turn off “  swmm_pipes.shp” in the Project Explorer. 

5.1 Mapping SWMM Attributes 

1. Turn on “  new” in the Project Explorer. 

The TIN must be visible in order for the elevations to properly map. 

2. Switch to the Map Module . 

3. Select Storm Drain | Map → 1D Schematic to bring up the Select Model dialog. 

4. Select “SWMM” from the drop-down at the bottom of the dialog and click OK to 
close the Select Model dialog. 

5. Click OK when advised the active TIN was used to assign elevations. 

This converts the storm drain coverage to a network of links and nodes recognized by 
SWMM (Figure 8) and automatically maps the elevations from the TIN to the ground 
elevations stored at each node. WMS then computes the length of each storm drain link 
and applies a default invert elevation of eight feet below the ground elevation.  

5.2 Node Invert Elevations and Outlet Linking 

1. Turn off everything in the Project Explorer except for the “  SWMM Hydraulic 
Schematic”. 

2. Select “  SWMM Hydraulic Schematic” in the Project Explorer to make it active. 

3. Using the Select Hydraulic Node Tool , double-click on any node to bring up 
the Hydraulic Properties dialog. 

4. Select “All” from the Show drop-down. 

Notice the invert elevation of Node 6 and Node 5. Storm water is supposed to flow from 
Node 6 to Node 5, but the default invert elevation is higher at Node 5 than at Node 6 
(about “4502.8” versus about “4502.2”, respectively). A similar issue exists with respect to 
Node 8 and Node 7. This dialog allows the default invert elevations to be changed at 
each node. 
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      Figure 8      Link-node schematic for SWMM model 

Note that node numbers mentioned below may not match node numbers in the model in 
the Graphics Window. Use Figure 8 as a reference to determine which nodes correspond 
to node and link names in the model. 

5. Enter “4501.8” in the Invert Elevation column on the Node 5 row. 

This elevation must be higher than that at Node 3. The elevation at Node 3 is about 
“4501.5”, which is acceptable. 

6. Enter “4508.0” in the Invert Elevation column on the Node 8 row. 

This elevation is now higher than the elevation at Node 7 (“4507.5”).  

Now notice the Linked Outlet Name column. The storm drain nodes are not currently 
linked to the hydrologic analysis. The peak flows calculated in the Rational Method 
Analysis should be used as inflows to the storm drain system. 

7. Click OK to close the Hydraulic Properties dialog. 

8. Right-click “  SWMM Hydraulic Schematic” and select Link Outlets to 
Nodes… to bring up the Link Storm Drain and Drainage Nodes dialog. 

9. Click Auto Link.  

This automatically links the storm drain nodes to the drainage outlets within a given 
tolerance of the node. Notice that Node 3 is not located close enough to any drainage 
outlet and so has not been linked. 

10. Click OK to exit the Link Storm Drain and Drainage Nodes dialog. 

5.3 Link Invert Elevations and Diameters  

Now that the node elevations have been changed and linked to the outlets, the upstream 
and downstream invert elevations of the links must also be modified. 

1. Using the Select Hydraulic Link Tool , double-click on any link to bring up the 
Hydraulic Properties dialog. 

2. Select “All” from the Show drop-down. 
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This dialog allows specifying the dimensions and other parameters of the storm 
drainpipes. The lengths and invert elevations are shown, but the invert elevations at Link 
6 and Link 8 need to be updated to reflect the changes made to the nodes. The diameter 
of the pipes also needs to be defined. As before, use Figure 8 as a reference. 

3. Enter “4501.8” in the Downstream Invert Elevation column on the Link 6 row. 

4. Enter “4501.8” in the Upstream Invert Elevation column on the Link 5 row. 

5. Enter “4508.0” in the Upstream Invert Elevation column on the Link 8 row. 

6. On the empty row at the top, in the Diameter/Height column, enter “4.0” to assign 
to all rows. 

7. Click OK to exit the Hydraulic Properties dialog. 

Now everything is ready to export an SWMM project file and run SWMM. Section 6 
describes how to export and run an SWMM model using the EPA SWMM program. See 
the steps in Section 8 to export to xpsmm format. 

6 EPA SWMM 

EPA SWMM is a version of SWMM developed by the Water Supply and Water 
Resources Division of the U.S. Environmental Protection Agency’s National Risk 
Management Research Laboratory. This section requires the EPA SWMM model be 
installed.  

6.1 Exporting and Opening an EPA SWMM File 

The EPA SWMM model offers many features that can be used to modify the hydrologic 
analysis, customize the drain system, and analyze the model output. A few of these 
helpful features are discussed here. 

1. Select SWMM | Run EPA SWMM… to bring up the Select an EPA SWMM File 
dialog. 

2. Select “EPA SWMM file (*.inp)” from the Save as type drop-down. 

3. Enter “epaswmmtut.inp” and click Save to export the file, close the Select an 
EPA SWMM File dialog, launch EPA SWMM, and open the exported file in EPA 
SWMM.  

6.2 Viewing the SWMM Inputs 

Many of the model inputs were calculated by and imported from WMS. The EPA SWMM 
window should display a storm drain schematic (Figure 9). 

1. On the Project tab of the SWMM Data Explorer, expand Hydraulics and Links, 
then select “Conduits”. 

A “Conduits” section will appear below the Project tab section of the SWMM Data 
Explorer. 
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      Figure 9      Cougar Estates storm drain schematic in EPA SWMM 

2. In the “Conduits” section, select “Link1”. 

3. Double-click the blinking link icon corresponding to the selected link to bring up 
the Conduit Link1 dialog. 

Notice that the link shape, maximum depth, and length specified and computed in WMS 
were exported to EPA SWMM. 

4. Click the  in the top right corner to close the Conduit Link1 dialog. 

5. In the SWMM Data Explorer, expand Nodes and select “Junctions”. 

A “Junctions” section will appear below the Project tab section of the SWMM Data 
Explorer. 

6. In the “Junctions” section, select “Node1”. 

7. Double-click on the blinking node icon corresponding to the node selected to 
bring up the Junction Node1 dialog. 

Notice that the invert elevation of the node that WMS computed was exported to EPA 
SWMM. 

8. Click the  in the top right corner to close the Junction Node1 dialog. 

9. In the SWMM Data Explorer, expand Hydrology and select “Subcatchments”. 

A “Subcatchments” section will appear below the Project tab section of the SWMM Data 
Explorer. 

10. In the “Subcatchments” section, select “1B”. 

11. Double-click on the blinking subcatchment icon corresponding to the 
subcatchment selected to bring up the Subcatchment 1B dialog. 

12. Click the   in the top-right corner to close the Subcatchment 1B dialog. 

Notice that the subcatchment area was computed by and imported from WMS. Feel free 
to explore the rest of the model inputs within the EPA SWMM interface.  
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6.3 Running SWMM and Viewing Output 

1. In EPA SWMM, select Project | Run Simulation to bring up the Run Status 
dialog. 

2. Once the run completes successfully, click OK to close the Run Status dialog.   

3. Select Report | Status to bring up the Status Report screen within the EPA 
SWMM Main Graphics Window. 

4. Review the output. When finished viewing the output, click the  in the top-
right corner to close the Status Report dialog. 

Notice that the size of the pipes could be reduced, and the flow would still be contained in 
the pipes without surcharges. Also notice that the Rainfall/Runoff model included with 
SWMM was not run because the discharges at the nodes have already been defined.  

If needing to run the Rainfall/Runoff model, turn this option on in the project options. Then 
remove the inflows at each of the nodes since these would be computed using the 
hydrologic model. 

5. Select Window | 1 Study Area Map to switch back to the schematic. 

6. Select the drainage outlet node at the bottom of the schematic. 

7. Click Create a Profile Plot  to bring up the Profile Plot Selection dialog (Figure 
10). 

 

      Figure 10      Profile Plot Selection dialog with data already filled in 

8. Click the + button next to the End Node field to add the selected node name to 
the End Node field.  

9. Move the Profile Plot Selection dialog out of the way, if necessary, and select 
one of the most upstream nodes in the drainage schematic. 

10. Click the + button next to the Start Node field to add the selected node name to 
the Start Node field. 

11. Click Find Path to show the path in the Links in Profile section. 
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12. Click OK to close the Profile Plot Selection dialog and bring up a “Water 
Elevation Profile” plot (Figure 11).  

This plot shows the results of the steady state analysis with the rational flowrates. Feel 
free to explore the rest of the EPA SWMM post-processing tools to view the results from 
the Cougar Estates model run.  

 

      Figure 11      Elevation v. Distance plot from an upstream to a downstream node in the model 

13. When done reviewing the results and exploring the EPA SWMM tools, click the 

 in the upper-right corner to close EPA SWMM. 

14. If prompted to save the current simulation, feel free to do so, and then return to 
WMS. 

7 Routing Hydrographs in SWMM 

In previous sections, the rational method was used to compute peak flows which were 
then exported to an SWMM model. Now use the rational method to compute hydrographs 
at each outlet, then route these hydrographs through the SWMM model. 

7.1 Computing Rational Method Hydrographs 

1. Select “  Drainage” in the Project Explorer to make it active. 

2. Switch to the Hydrologic Modeling Module . 
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3. Using the Select outlet  tool, double-click outlet “2C” (the outlet for the entire 
drainage) to bring up the Rational Method dialog. The SWMM node icon may 

partially obscure the “2C” icon, so feel free to Zoom  in if needed. 

4. In the Display section, select “Selected” from the Show drop-down. 

5. Click the Compute… button on the Compute Hydrographs row in the Outlet 
column to bring up the Rational Method Hydrographs dialog.  

6. Click Done to compute the hydrographs and close the Rational Method 
Hydrographs dialog. 

7. Click OK to exit the Rational Method dialog. 

8. Notice that each basin and outlet icon shows a hydrograph icon (Figure 12). 

 

      Figure 12      Rational Method hydrographs for SWMM 

9. Select “  SWMM Hydraulic Schematic” in the Project Explorer. 

If using EPA SWMM, follow the steps below. If using XPSWMM, follow the directions in 
Section 8. 

10. Select SWMM | Run EPA SWMM… to bring up the Select an EPA SWMM File 
dialog.  

11. Enter “swmm_hyd.inp” as the File name.  

12. Click Save to close the Select an EPA SWMM File dialog and open the file in 
EPA SWMM. 

7.2 EPA SWMM: Running and Viewing Results 

1. In EPA SWMM, select Project | Run Simulation to bring up the Run Status 
dialog. 

Notice that the run was successful. 

2. Click OK to close the Run Status dialog. 
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3. Select the conduit connecting the most downstream outlet to the junction just 
upstream. 

4. Click the Create a Time Series Plot  button to bring up the Time Series Plot 
Selection dialog. 

5. To add other links, select them in the EPA SWMM Graphics Window and click 

 in the Time Series Plot Selection dialog to add them to the list in the Data 
Series section. Click Accept if the dialog asks to specify the object and variable 
to plot. Move the Time Series Plot Selection dialog out of the way, if necessary. 

6. After all the desired links (or maximum amount of links) have been added, click 
OK to close the Time Series Plot Selection dialog and bring up the Graph dialog. 

This plot shows the Flow versus Elapsed Time. The water depths, velocity, volume, and 
capacity in the storm drains can also be viewed by selecting the desired option from the 
Variable drop-down in the Data Series Selection dialog which appears each time a new 
link is added in the Time Series Plot Selection dialog. 

7. Right-click on the plot to bring up the Graph Options dialog.  

8. On the Axes tab, select Bottom Axis and enter “0.5” as the Minimum, “5.0” as the 
Maximum, and “0.25” as the Increment and click OK to close the Graph Options 
dialog and return to the plot (Figure 13). 

 

      Figure 13      Plot of Flow vs. Time for several links in the model 

8 Exporting to XPSWMM 

This optional section describes how to export an XPSWMM model. If XPSWMM is not 
installed, skip this section. The XPX file is an XPSWMM project file. Using XPSWMM 
requires a separate license purchased directly from XP Solutions. 

1. Select SWMM | Run xpswmm… to open the Select an XPX File dialog. 

2. Select “XPX file (*.xpx)” from the Save as type drop-down. 

3. Enter “swmmtut.xpx” as the File name and click OK to exit the Select an XPX 
File dialog and open the XPX file in XPSWMM. 
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9 Conclusion 

This concludes the “Storm Drain Modeling – SWMM Modeling” tutorial. The following key 
topics were discussed and demonstrated: 

• Defining runoff coefficients 

• Computing flows using the rational method 

• Importing a pipe network 

• Running SWMM and viewing results 

• Routing hydrographs using SWMM and viewing results 

• Feel free to continue exploring the WMS interface or the EPA SWMM interface 
more thoroughly, if desired. 

 


